
 
 Page  

1 of 48 

Prepared by:  Date File name Rev 

LL  2007-05-25 Orion Analyzer User Manual 0.10 

 

u-Nav Microelectronics Proprietary and Confidential Orion Analyzer User Manual 

ORION ANALYZER 

Orion Analyzer User Manual 

 



 
 Page  

2 of 48 

Prepared by:  Date File name Rev 

LL  2007-05-25 Orion Analyzer User Manual 0.10 

 

u-Nav Microelectronics Proprietary and Confidential Orion Analyzer User Manual 

CHANGE HISTORY 

Date Rev Author Status Description of changes 

2005-06-17 0.1 ROK Draft Initial document version 

2005-10-14 0.2 ROK Draft Snapshots were updated 

2005-11-11 0.3 ROK Draft Redesigned 

2005-11-21 0.4 ROK Draft Redesigned after review 

2005-11-22 0.4 LL Draft Proofreading 

2006-09-21 0.5 LL Draft Proofreading 

2006-09-22 0.6 LL Draft Abbreviations 

2006-10-06 0.7 LL Draft Snapshots updated 

2006-10-10 0.8 LL Draft Position Plot details added, proofread 

2006-12-19 0.9 LL Draft Spell check 

2007-05-25 0.10 LL Draft Update (v. 2.3.16 -> 3.0)  

REFERENCES 

1. Orion User Manual 

2. u-Nav Binary Protocol Specification for SDK Users 

3. NMEA 0183 Standard For Interfacing Marine Electronic Devices 

ABBREVIATIONS 

Acronym Description 

ASCII American Standard Code for Information Interchange (ASCII) is a character set and a 

character encoding based on the Roman alphabet as used in modern English. ASCII 

codes represent text in computers, in other communications equipment, and in control 

devices that work with text. Most recent character encoding has an ASCII-like base. 

Baud In telecommunications and electronics, baud is a measure of the "signaling rate" which 

is the number of changes to the transmission media per second in a modulated signal. 

For example: 250 baud means that 250 signals are transmitted in one second. If each 

signal carries 4 bits of information then in each second 1000 bits are transmitted. This 

is abbreviated as 1000 bit/s. 

COM An interface on a computer system with which information is transferred in or out one 

bit at a time. Throughout most of the history of personal computers, this was 

accomplished using the RS-232 standard over simple cables connecting the computer 

to a device such as a terminal, modem or GPS receiver. 

DLL Dynamically Linkable Library. Used in Windows operating systems for shared / 

common / separated code to be loaded and linked to the main program at the run time. 
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EGNOS The European Geostationary Navigation Overlay Service (EGNOS) is a satellite 

navigation system under development by the European Space Agency, the European 

Commission and EUROCONTROL. 

GPS Global Positioning System (the US military refers to it as NAVSTAR GPS) is a satellite 

navigation system used for determining precise location and providing a highly 

accurate time reference almost anywhere on Earth or in Earth orbit. It uses an 

intermediate circular orbit (ICO) satellite constellation of at least 24 satellites. 

GPS Receiver Electronic equipment that passively receives GPS signal for processing. A receiver 

may be hand-held or permanently mounted on a vehicle. 

GUI Graphical User Interface 

NMEA A combined electrical and data specification for communication between marine 

electronics and also, more generally, GPS receivers. The protocol is a means by which 

marine instruments and also most GPS receivers can communicate with each other. It 

has been defined and is controlled by the US based National Marine Electronics 

Association. 

PC Personal Computer 

Plug-In Plug-in is a computer program that can, or must, interact with another program to 

provide a certain, usually very specific, function. In Orion Analyzer it means DLL file, 

where part of Orion Analyzer functionality has been implemented. 

PRN Pseudo Random Noise 

RS-232 A standard for serial binary data interconnection between a DTE (Data Terminal 

Equipment) and a DCE (Data Communication Equipment). It is commonly used in 

computer serial ports. A similar ITU-T standard is V.24. 

SBAS Satellite Based Augmentation System 

UBP u-Nav Microelectronics Binary Protocol 

u-Nav Orion Receiver Standard GPS receiver which produces NMEA and UBP data 

WAAS The Wide Area Augmentation System (WAAS) is an extremely accurate navigation 

system developed for civil aviation by the Federal Aviation Administration in conjunction 

with the United States Department of Transportation. 

XML The Extensible Markup Language (XML) is a W3C-recommended general-purpose 

markup language for creating special-purpose markup languages, capable of 

describing many different kinds of data. Its primary purpose is to facilitate the sharing of 

data across different systems, particularly systems connected via the Internet. 
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1 ORION ANALYZER 3.0 OVERVIEW 

Orion Analyzer is a Windows
®
 application which is used to connect a GPS receiver via RS-

232 connection to a PC for visualizing and analyzing the received data. 

Orion Analyzer supports unrestricted amount of GPS receivers simultaneously. GPS 
receiver can be a third-party manufactured receiver or u-Nav Microelectronics GPS 
receiver (u-Nav Orion receiver). 

u-Nav Orion receiver produces NMEA messages [3] and  UBP [2] messages. NMEA 
protocol contains only navigation data, whereas UBP message format features more 
detailed information useful in analyzing GPS navigation results. Orion Analyzer can be 
configured for both of these protocols from all receivers. 

One of the exciting Orion Analyzer features is that all the received messages can be 
recorded to log files for later play back operation and analyzing. 

As Orion Analyzer environment, the following is recommended: 

• Computer with a 600 MHz or faster processor192 MB of RAM or more 

• 50 Mb of available hard-disk space 

• 1024x768 or higher-resolution display with minimum 256 colors 

• Keyboard and Microsoft Mouse or compatible pointing device 

Orion Analyzer can be installed on the following operating systems: 

• Microsoft
®
 Windows

®
 2000 with Service Pack 4 

• Microsoft
®
 Windows

®
 XP with Service Pack 2 

The program consists of several binary files (one main EXE and several plug-in DLL files 
for extensible functions). When the program is executed, it checks all plug-in DLL files 
(later called views) and loads compatible ones. Those plug-in files implement different 
functions that are used for receiving or analyzing the data in human readable form. 

1.1 Features 

The main Orion Analyzer features are: 

• Unlimited amount of GPS receivers that Orion Analyzer can work on simultaneously 
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• Lots of different Plug-Ins for visualizing data 

• Recording and playing back data operations with different formats 

• Managing and controlling GPS and u-Nav Orion receivers through NMEA and UBP 
commands 

• Uploading new Orion binary to the u-Nav Orion receiver 

• Ability to create, load and work with different work settings 

1.2 Software and Hardware Environment 

Note: Before starting to use Orion Analyzer with the GPS receiver, please read the user 
manual of the receiver, how to set it up and connect it to the host running the Orion 
Analyzer application. 

Orion Analyzer application is compatible with Microsoft Windows
®
 2000 operation system 

and Microsoft Windows
®
 XP. 

The PC should have two serial ports (or at least one) for interaction with the receiver: 

• By default COM port 1 is used for NMEA protocol (baud rate 4800) 

• By default COM port 2 is used for UBP protocol (baud rate 115200) 

1.3 Installing the Software 

Orion User Manual document [1] has the installing instructions for getting the tool into your 
computer. The Orion binary file can be uploaded to the u-Nav Orion receiver as soon as 
the tool has been set up correctly. 

1.4 Uninstalling the Software 

Orion User Manual document [1] contains instruction for uninstalling the package. 
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2 ORION ANALYZER ARCHITECTURE OVERVIEW 

The basic module division consists of the main program (Orion Analyzer executable file) 
and Plug-In libraries (DLL files). Plug-In libraries are located in Plug-Ins subdirectory. 
During the start-up time Orion Analyzer searches for Plug-Ins and automatically loads 
them. 

Plug-In library consists of two major entities: the Receiver Plug-In and the Viewer Plug-In 
(Viewer). They may have several instances and several different types of entities. For 
example the “Serial Communication Port” Plug-In implements functionality for reading and 
writing data from the serial port. The data is interpreted according to correct protocol form 
and ready messages are sent ahead to the Viewer Plug-Ins. Each Viewer Plug-In receives 
messages and visualizes them. 

 

Figure 2-1. Orion Analyzer Architecture Overview 

2.1 Protocols 

Orion Analyzer supports both NMEA [3] and the u-Nav proprietary protocol [2]. 

UBP message format contains more detailed information about u-Nav Orion Receiver and 
GPS navigation and it is very useful for observing and analyzing the data. 
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When u-Nav Orion Receiver is used as standard GPS receiver and navigation behavior is 
investigated, u-Nav Microelectronics recommends using UBP protocol instead of NMEA 
protocol. UBP includes everything available with NMEA plus additional proprietary 
information unique to the u-Nav Orion receiver. The examples below focus on UBP, but 
most of them are applicable to NMEA as well. 

2.2 Receiver Plug-In Logic 

The new Receiver Plug-In instance is created when the user opens a new connection. 
There are two different connection types available: 

• Serial Communication Port 

• File reading device / Log player 

Receiver Plug-In supports two types of protocol: 

• NMEA protocol 

• UBP protocol 

Orion Analyzer core creates new output console window (for more details see chapter 4.2) 
for each instance of the Receiver Plug-In. The receiver sends all received messages to the 
core of Orion Analyzer at run time. The core forwards the messages to the suitable Viewer 
Plug-In instances and to the console. 

Each instance of Viewer Plug-In receives the messages; some keep the messages as a 
history queue, some may discard the message immediately after having read its content. 

The Receiver Plug-In works until the user disconnects it. All allocated resources including 
the created connection instance are freed, and the registered Viewer Plug-Ins are notified 
about the disconnection. 
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Figure 2-2. Receiver Plug-In Logic 

2.3 Viewer Plug-In Logic 

The Viewer Plug-In instance is created when the user wants to open a new view to see and 
analyze the received data. 

The Viewer Plug-In understands two different types of messages: 

• NMEA messages 

• UBP messages 

Basically, the Viewer Plug-In instance just waits for incoming messages. When a message 
appears from the Receiver Plug-In instance, it is forwarded to the Viewer Plug-In instance. 
The Viewer Plug-In functionality calculates the needed steps and renders the results to the 
window for user viewing. 

The Viewer Plug-In works by receiving messages and drawing data to the screen until the 
user closes it. On the close all allocated resources are freed and the message receiving 
connections to the Receiver Plug-In instance are disconnected. 
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Figure 2-3. Viewer Plug-In Logic / NMEA Protocol 

2.4 Data Record Logic 

When the Receiver Plug-In instance is established, the user may start to record the 
received data. In this case several recording instances can be created for one receiver 
object (e.g. one per each type of recording) and they are attached to the appropriate 
Receiver Plug-In instance. 

 

Figure 2-4. Record Operation 

For different types of connections, different recording formats are available: 

• Receiver Plug-In connection with NMEA protocol supports: 

o ASCII recording format – each message is stored as one line in the text file 
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o XML recording format – each message is saved as XML nodes with 
formatting 

• Receiver Plug-In connection with UBP protocol supports: 

o Binary format - different types of messages are stored in different binary 
files. The main record file (index) keeps references to other files 

o XML format - each message is saved in text format as XML nodes 

2.5 Work Settings Logic 

Orion Analyzer supports saving and loading work settings. All Viewer Plug-In instances, 
window positions and current connections are saved in the file settings. Later on the setting 
file can be loaded and work environment restored. 

Note: Only one exception, the current setting, will not be saved but default work setting will 
be restored if “File reading device / Log player” is used. 

3 QUICK START 

To start Orion Analyzer application, double click the Orion Analyzer application shortcut on 
the desktop. 

3.1 First Start 

When starting Orion Analyzer for the first time, the main window with default session will be 
opened. 

Next time Orion Analyzer will open the latest working session. The default session opens 
serial port COM1 for receiving NMEA messages. 
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Figure 3-1. Orion Analyzer Default Session 

For editing the session, go to File menu and select “Edit Connection” item. “Edit 

Connection” dialog can also be opened by pressing CTRL-E, or clicking on the  
icon in the tool bar. 

On the “Edit Connection” also port number or baud rate can be changed. 
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4 ORION ANALYZER GRAPHICAL USER 
INTERFACE 

4.1 Main Window 

The main GUI of Orion Analyzer has been divided in five areas: main menu, toolbar, client 
area, output console and status bar. Toolbar, output console and status bar can be 
disabled from the menu (“Menu -> View”) to get more space for the client area views. 

The main GUI offers a possibility to print a snapshot of the main window. The print is fitted 
on paper so that the print uses the whole paper area in one dimension. The user may 
choose printer and fitting from the print setup (File -> Print). The printed area is the toolbar, 
the client area, the output console and the status bar. It is also possible to get a rough 
preview of the print using “File -> Print Preview” command. 

4.2 System Output Console 

The system output console is a docking tab control for the system information. The basic 
tab page is “output”, which shows basic information from the system at run time, for 
example errors and events. Each Receiver Plug-In instance adds at least one window to it 
(like navigation console for NMEA connection in Figure 4-1 ). 

Other windows are Receiver Plug-In related tab pages. The view shows the basic 
information of messages independent of the protocol. A new tab page is added for each 
Receiver Plug-In instance. 

For example, NMEA connection shows the original NMEA messages. 
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Figure 4-1. System Output Console 

 
Output Console highlights messages with invalid checksum.  
 

4.3 File Menu 

4.3.1 New Connection 

A “New Connection” dialog can be opened by pressing CTRL-N or clicking the  
icon in the tool bar. 

 

Figure 4-2. New Connection / Serial Communication Port 

The basic device type is “Serial Communication Port” that is connected to any serial port in 
the computer. 

Please select the appropriate protocol type, serial port and baud rate - or the default values 
- and after that click the “Create” button. The new Receiver Plug-In instance will be created. 
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“File reading device” Plug-In is used for play back mode, and to feed data from the 
recorded data file to Orion Analyzer. In principle it works in the same way as “Serial 
Communication Port” Plug-In, but the data is read from a file instead of a real 
communication connection.  

 

Figure 4-3. New Connection / File Reading Device 

“File reading device” Plug-In can only use the log files created by recording operation (see 
section 4.4.9). 

Be sure to set the Protocol radio button (NMEA or UBP) to match the log file. Browse to the 
subdirectory of the log session and select the Index file (for example: 
C:\OrionAnalyzer_Bin\NMEALog1.log). 

Note: It is important to select the correct protocol and index file. Incorrect settings may 
appear to be OK in playback, but no data will be displayed. 

 

The data can be played from the file in different speeds; by clicking the max button, the 
maximum speed can be reached. Rewind, Pause, Play and Step buttons are useful when 
studying the recorded data in detail. When markers are inserted, the data can be played 
from one marker to another. When running several logs at a time, by ticking the 
synchronize button, the logs can be rewound, paused and played at the same time within 
the log. 
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Figure 4-4. Playback 

By clicking the right mouse button while the mouse cursor is over the progress bar, the 
context menu opens with options to set playback position or marker. The user may set 
position or marker based on time or byte offset of the record.    

4.3.2 Edit Connection 

“Edit Connection” dialog can also be opened by pressing CTRL-E or clicking on the 

 icon in the tool bar. 

 

Figure 4-5. Edit Connection 

“Edit connection” dialog is used if the port or baud rate needs to be changed during the 
runtime. For NMEA play back mode also the log file name can be changed. 
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4.3.3 Pause 

 “Pause” blocks and resumes the selected connection without disconnecting it. The dialog 

can be opened by clicking the   button. 

4.3.4 Disconnect 

“Disconnect” dialog can also be opened by pressing CTRL-D or clicking on the  
icon in the tool bar.  

 

Figure 4-6. Disconnect 

“Replay/Online” is used for storing automatic log into disk where it can be replayed for 
more detailed information. Only a limited amount of messages can be saved. The amount 
can be checked at “Tools -> Settings -> Automatic Logging -> Maximum amount of 
messages”. The active connection can be closed by selecting the connection and pressing 
the “Disconnect” button. This will free up the connected communication port for different 
kind of use.  

4.3.5 Open Settings  

“Open Settings” dialog can also be opened by pressing CTRL-O.  
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Figure 4-7. Open Settings  

Orion Analyzer can work with different predefined work settings and this menu item is used 
for loading them. 

4.3.6 Save Settings  

“Save Settings” dialog can also be opened by pressing CTRL-S. 

When used for the first time, Orion Analyzer opens the default work settings (which are 
saved at defaults.xml file). During the work session the user can make modifications such 
as add additional receiver or open more views. This menu item is used for saving working 
modifications. 
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4.3.7 Save Settings As  

 

Figure 4-8. Save Settings As  

This menu item is used for saving working settings in a new file. 

4.4 Tools Menu 

4.4.1 Open View 

“Open viewer(s)” dialog can also be opened by pressing CTRL-Shift-V or clicking on the 

 icon in the tool bar. 
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Figure 4-9. Create New View / NMEA 

This dialog allows opening additional views by selecting the new view and pressing OK. 
Different protocols have different amount of available views. The figures above and below 
show the lists of available views for NMEA and UBP protocols, respectively. 
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Figure 4-10. Create New View / UBP 

4.4.2 Program Firmware 

“Program Firmware” dialog can also be opened by pressing CTRL-Shift-F or by clicking on 

the  icon in the tool bar. 

This dialog is used for uploading a new Orion binary to the board. Start by selecting the 
path and binary file with COF extension. After that choose the appropriate COM port and 
press “Start Flash” button. 

Note: If the selected COM port is already in use in the current session, it will be 
disconnected automatically before flashing operation and restored back after finishing. 
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Figure 4-11. Program Firmware  

4.4.3 NMEA Command 

“NMEA Command” dialog can also be opened by pressing CTRL-Shift-N or by clicking on 

the  icon in the tool bar. 
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Figure 4-12. NMEA Command  

The dialog is used for handling Orion through NMEA protocol. It allows getting version 
information in the output console at the bottom of the view, and changing start and stop 
modes. The user may select the Datum format from the drop down list. Also message 
types and baud rate may be changed. 

If the PC has only one COM port, this dialog allows switching from the NMEA protocol to 
the UBP protocol in Port Settings. 

Note: The NMEA checksum is automatically added to the NMEA command. Below are 
some examples on NMEA messages with individual checksums:  
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$GPRMC,001924.00,A,5028.61897,N,00340.63501,E,43.1948,45,010503,0,W*79  
$GPGSV,2,1,08,1,7,44,50,16,57,293,50,19,23,237,50,22,47,123,50*45  
$GPGSV,2,2,08,9,51,191,50,21,23,170,50,5,16,308,50,20,29,60,50*47  
$GPGGA,001925.00,5028.62745,N,00340.64830,E,8,08,2.7,2.7,M,47.3,M,,*61  
 

Note: It´s also possible to send NMEA commands over the UBP protocol just by selecting 
UBP connection from the “receivers” drop-down menu and typing in the command on 
NMEA command field. 

4.4.4 UBP Command 

“UBP Command” dialog can also be opened by pressing CTRL-Shift-U or by clicking on the 

 icon in the tool bar. 

 

 

Figure 4-13. UBP Command 

This dialog is used to handle the Orion through UBP protocol. It allows getting version 
information and changing start and stop modes. It also allows changing output type 
messages. 
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If the PC has got only one COM port, the dialog allows switching from UBP protocol to the 
NMEA protocol. 

4.4.5 Tagging 

Tagging mode is enabled by clicking “Tagging” button  or by selecting “Tagging” 
from the “Tools” menu (Ctrl + Shift + T). In tagging mode the user can insert tags into UBP 
or NMEA stream being recorded by pressing the configured keys. For more information 
about key configurations, see chapter 4.4.7.  

4.4.6 Converters 

This dialog is used for converting UBP and NMEA logs into other formats. After having 
browsed the appropriate files, press “Convert” to start conversion. 

The following four conversions are supported: 

• UBP-Log to NMEA-Log 

• UBP-Log to TRACE-Log 

• UBP-Log to GPX-Log 

• NMEA-Log to GPX-Log 

4.4.7 Settings 

The dialog is used to set up the global parameters that will be used during the session. 
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Figure 4-14. Settings: Units 

The units and date formats can be controlled with the above dialog. 

 

Figure 4-15. Settings: Automatic Logging 

The “Automatic Logging” disk usage can be controlled with the dialog above. The given 
limits are available for all Orion Analyzer views. It is possible for the user to specify the 
amount of messages shown by replacing the default 800 messages with the desired 
amount. The rest of the values reflect the memory consumption of the program. “Refresh” 
button updates these values.  
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Figure 4-16. Settings: Tagging 

The user can configure the key bindings and tag names. The key binding is configured by 
clicking the key field and pressing the desired key. Function keys (F1- F12), spacebar and 
alpha-numeric keys can be assigned. Tag name can be up to 10 characters long. The 
default configuration is restored by clicking the “Defaults” button. Each tag has an index 
numbering from 0000 to 9999, and it can be reset by pressing the “Reset Indices” button. 

4.4.8 Data Files 

The dialog allows exporting Ephemeris and/or Almanac data to the XML or TXT formats. 
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Figure 4-17. Data Files 

4.4.9 Record -> Start 

“Record” dialog can also be opened by clicking on the  icon in the tool bar. 

Once the connection has been established, logging begins by selecting “Record”. The 
dialog box presented below in Figure 4-18 prompts for the log file settings. Choose the 
receiver protocol, set the session path appropriately for your computer directory and select 
appropriate log type. 

 

Figure 4-18. Record -> Start  

4.4.10 Record -> Stop 

“Stop Record” dialog can also be opened by clicking on the  icon in the tool bar. 
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Figure 4-19. Record -> Stop  

If recording operation is turned on, this dialog allows stopping the recording. Orion Analyzer 
automatically stops recording when the connection is closed. 

5 VIEWS 

In the Client Area, a set of different views can be chosen for observing and visualizing data. 
Nine of them are available for both NMEA and UBP protocol, and two more for UBP only. 

5.1 Dynamics View 
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Figure 5-1. Dynamics View: Graphical Format 

The dynamics view combines four different views inside one window. The views are 
“Speed”, “Vertical speed”, “Compass” and “Height”. The data of these views is shown in 
both textual and a graphical format. Using context menu (mouse right click), the graphical 
mode can be switched to the text mode to make more window space available (“Hide 
graphics”). It is possible to hide one or more views in order to make important views more 
visible (“Settings”). These operations are available from the context menu. 

 

Figure 5-2. Dynamic View: Textual Format 

The size of the window can be changed, and the graphical figures resized accordingly. 
There are four adjustment modes: auto, side by side, one upon another and two rows. The 
adjustment mode and how many views are shown can be set to default in the context 
menu. 

5.2 Globe View 

Globe View is available for UBP connection only. 

 

Figure 5-3. Globe View 

Globe view shows the positions of all available satellites around the world. The positions 
are based on position information of UBP messages (satellite info message). Every time a 
new position of satellite is received, it is updated to the view. It is possible to see all GPS 
satellite positions on the screen at the same time. In addition, SBAS satellites, WAAS and 
EGNOS are shown with different color symbols. By the right click of the mouse, the grid 
lines on the globe can be toggled on or off. 
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Globe view also shows the position of the navigation point on the world map with a black 
square. A more detailed look on the satellite locations can be taken via the position plot. 

5.3 GPS Satellite Data 

The GPS Satellite Data view in Figure 5-4 below is available for UBP connection only. 

 

Figure 5-4. GPS Satellite Data 

The GPS satellite data view is a grid view to show the basic information of available 
satellites. Only the information available is shown – other fields are empty. 

In Satellites column PRN stands for pseudo random noise, Az for azimuth and Ele for 
elevation. 

In Track, the tracking bits are coded in the following way: 

• f - Frequency lock 

• C - Code lock 

• B - Bit sync 

• F - Frame sync 

• T - TOW decoded 

• P - Parity check 

• C/No – Signal strength 
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The colors in Track, columns from f to T have no specific meaning, just delimiting the 
subcolumns. In column P the red color means parity check error. 
 

In Subframes, columns 1 to 5 are the frame numbers, H stands for the satellite health 
status.  

In Subframes, columns 1 to 5 the light blue color means the receiver has already acquired 
subframe information from the satellite and the dark blue color that the receiver is at the 
moment acquiring subframe information from the satellite. 
The Subframe empty column H means that satellite produces correct, healthy signal. The 
red color in the column indicates the signal is not healthy. The “bad health” information 
means that the satellite is “dead” (i.e. not available for navigation purpose). 

The Quality column abbreviations stand for the following: 

• CP - Code Phase check (channel must be in code sync) 

• CC - Cross Correlation check 

• SP - Satellite Position calculation has succeeded (or not) 

• PR - PRN in Range (1…32) 

• EL - Elevation check 

• U - Used in navigation 

• DD - Doppler Differences 

• GD - Gross Doppler test (tests the difference between the estimated and measured 
dopplers) 

• PD - Pseudo range differences   

• GP - Gross Pseudo range test  

• CN – C/No check 

In Quality column the green color indicates good signal quality and yellow not good quality. 

5.4 History View 

History View has two dialogs for controlling the view and visualizing and analyzing the 
satellite history.  
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Figure 5-5. History View: Output Data 

5.4.1 Output Data  

The context menu for the Output Data dialog can be launched by the right click of the 
mouse. The view can be zoomed in and out, and controlled with the options shown in 
Figure 5-6. In the Settings menu the following options may be selected: 

 

• Dynamics: altitude in meters, heading in degrees and speed in kilometers per hour 

• Satellite Counts: PRNs in view, in track and in fix 

• Fix Data: fix mode, HDOP, VDOP and PDOP 

• Satellite Data: elevation and azimuth in degrees, and signal to noise in dB-Hz 
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Figure 5-6. History View: Settings 

The ranges can be either ticked with Auto scale Y- and/or X-axis, or defined with 
maximums and minimums, and having the time stamps either shown or hidden.  

5.4.2 Visible Satellites 

The Visible Satellites dialog shows all the satellites with PRN numbers that are visible at 
the time, with three different shades of blue color. 
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Figure 5-7. History View: Visible Satellites 

5.5 Message Scroll 

 

Figure 5-8. Message Scroll 

The message scroll view shows all received messages from one receiver. It shows the 
basic information of the message: receiving time, protocol, status and message name. 
“Pause” button interrupts updating of the window and “Clear” removes the messages. The 
user may choose certain type of messages by pressing “Set filter” button. After applying 
user defined filter only selected messages will be shown. 

When the message row is double clicked, the message is opened to the message view for 
details.  
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Figure 5-9. Message Scroll: details 

By ticking “Renew message automatically” the view will be set to update its content 
automatically. By clicking the arrow up, previous message of the same type is displayed, 
and the arrow down displays next message. 

It is also possible to pause the scroll and configure a filter for the messages. The user can 
select the message type according to which messages are wanted on the screen; see 
Figure 5-10 below.  

 

Figure 5-10. Message Filter 
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5.6 Message Tree 

 

Figure 5-11. Message Tree 

The message tree view shows the last instance of any received message type from one 
receiver. The user can see the tree view of all supported message types from each 
configured protocol. When a new message arrives, the appropriate message type name 
will be bolded. When the user clicks with mouse the tree branch, the received message will 
be opened to the right side of the tree view. 

5.7 Navigation Data 

 

Figure 5-12. Navigation Data: NMEA Protocol 
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Figure 5-13. Navigation Data: UBP Protocol 

The navigation data view is a text-based view that shows navigation related parameters. 
Different views are used for and NMEA and UBP protocols. The parameters are read 
directly from the data of the received messages. For UBP protocol the view also indicates 
whether the almanac or ephemeris information of each single satellite is available or 
received. Yellow color indicates received almanac information, green is used for received 
ephemeris information. If the satellite is marked with both yellow and green color, then both 
almanac and ephemeris information is available.  

5.8 Position Plot 

The position plot view, Figure 5-14 below, shows the position of the fix on the plot. By 
default, the view shows grid lines. It is possible to follow up to 8 fix positions at the same 
time. The view shows the whole world size grid by default. Auto panning and zooming are 
enabled right from the start. Immediately after the first received fix information, the grid is 
zoomed and scaled around the fix. The used grid scale is about 5 meters after the auto-
zoom. 
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Figure 5-14. Position Plot 

5.8.1 Context Menu 

The Context menu can be launched by the right click of the mouse. It is used to customize 
the View.  

 

Figure 5-15. Position Plot: Context Menu 
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Position Plot Context provides the following functions:  
 
Settings -  launches the Settings dialog 
Grid in metrics / 
Grid in degrees-   switches between measuring coordinates in degrees and 

metrics 
Grid on/off -  selects/deselects grid to be drawn 
Save as -  saving the position plot for later use  
Pan -  allows user to move the entire map (i.e. “central point” 

move) relative to coordinates by dragging it with the mouse 
while left button is pressed 

Zoom in -  enables user to stretch a rectangular contour while holding 
left mouse button pressed and, after releasing the button to 
see the area covered by rectangle enlarged (scale down) 

Zoom out -   enables user to go back to less detailed view of the map 
(scale up) 

Measure distance - allows the measuring of the distance between to points by 
pressing left button and stretching the line from the starting 
point. Distance in meters is drawn at the bottom of the View. 

Fit fixes to view - fitting all way points in the rectangle of the Position Plot view 
Fit map to view - this option is not available for Orion Analyzer (this feature is 

for Orion Workbench only) 
Auto fit to view - automatic rescaling, three options: 

Keep receivers in view:  makes the View draw each receiver's route if checked 
Autozoom:  switching between automatic view rescaling and manual 

one. Also enables X and Y spacing Map Settings Dialog. 
Autopan:   switching between automatic moving of the “central point” of 

the view through the map and the manual one (See the Pan 
mode) 

Reset data -   clears the view from already drawn way points (fixes) 
 

5.8.2 Map Settings 

The Map Settings dialog below in Figure 5-16 provides configuration settings for the 
Position Plot view.  
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Figure 5-16. Position Plot: Map Settings 1 

Receivers  This group of settings refers to receivers i.e. independent 
sources of GPS-navigation data (UBP and NMEA; see the 
Connections dialog, chapters 4.3.1 and 4.3.2).  

In the top left corner of this dialog there is a Receivers 
check-list with all available, connected receivers. The user 
can choose a set of receivers he or she would like to explore 
with Position Plot by checking the appropriate receiver from 
the list. 

Route length - the number of fixes (position messages) to be drawn 

Main color - the color to draw accessory items (reserved for future use) 

Route - the color to draw way points (fixes) 
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Figure 5-17. Position Plot: Map Settings 2 

 

The routes of two receivers are shown in different colors in the Position Plot below: 

 

Figure 5-18. Position Plot: Two Receivers' Routes 

 

The route color drawing the way points is shown in green color in the Position Plot below: 



 
 Page  

44 of 48 

Prepared by:  Date File name Rev 

LL  2007-05-25 Orion Analyzer User Manual 0.10 

 

u-Nav Microelectronics Proprietary and Confidential Orion Analyzer User Manual 

 

Figure 5-19. Position Plot: Route Color 

Route color per segment: checking this box in the Map Settings dialog, together with 
selecting different route colors, results in different colors for the route segments; see below. 

 

Figure 5-20. Position Plot: Route Color per Segment 

 

Speed color gradient: checking this box enables route coloring according to velocity. The 
darkness of the color indicates the velocity for each dot: the darker the slower, the lighter 
the faster. 
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Figure 5-21. Position Plot: Speed Color Gradient 

 

X-Spacing and Y-Spacing: This option is enabled by un-checking Autozoom in the 
context menu (switching between the automatic view rescaling and the manual one).  

X and Y spacing mean latitude and longitude scale in meters. This allows the user to fix the 
scaling as he or she wants. Be aware that the option “Keep same x-y ratio” from the 
General group of this dialog enables the user to select a fixed setting for both x and y 
coordinates by specifying just X-spacing. 

General  This group of settings refers to the entire Position Plot. 

Show arrow to North -  by checking this box the user makes the view to show the 
direction to North: 

 

Show marker points -  reserved for future use 

Draw map border -  draws a border over the entire map 

Keep same xy-ratio -  keeps the same latitude / longitude ration while positioning 
the plot 

Keep bitmap ratio -  keeps the bitmap in actual ratio 

Arrows for heading -  makes Position Plot draw arrows heading to the direction of 
the movement reported by GPS 
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Figure 5-22. Position Plot: Arrows for Heading 

5.9 Signal Strength View 

 

Figure 5-23. Signal Strength View 
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The signal strength view is a graphical view for the signal strengths (signal/noise) of the 
satellites. The view can show all GPS satellites at the same time. The column shown may 
have three different states: “Not Used”, “Used 3D”, and “Used 2D”. The state “Not used” 
tells that the satellite could have been used for navigation, but was not used (e.g. because 
of bad angle or weak signal). So the state “Used” tells that the satellite is used, either in 3D 
or 2D mode. 

The context menu can be launched by the right click of the mouse. In the Settings dialog 
the user can select if all the PRN numbers are shown or not, and also change the minimum 
and maximum ranges. The navigation can be reset by choosing Reset data.  

5.10 Sky Plot View 

 

Figure 5-24. Sky Plot View 

The sky plot view is a graphical view of available satellites. Each of them is shown 
immediately when the satellite position information is received. The satellite symbols shown 
may have two different states: “Not Used” and “Used”. The state “Not Used” tells that the 
particular satellite could have been used in navigation, but was not (e.g. because of bad 
angle or weak signal). “Used” means that the satellite was used in the positioning. 

Sky plot shows the satellites on the sky from the receiver location. Zero on the outer ring 
refers to North, the other numbers to the direction (azimuth) measured in degrees. The 
distance from the center refers to the satellite elevation angle. 
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5.11 Time View 

 

Figure 5-25. Time View 

The time view is a very simple graphical view that shows the time of the received position 
fix. Every time a new position fix information is received, the received time stamp is shown 
on the view. It is possible to configure local time offset by the right click of the mouse. The 
time is then shown as shifted by the given offset. 


